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Preface

This guide explains how to use the Conductor software to communicate with a GPS
receiver for collecting, displaying and analyzing data.

Intended Audience

This guide aids GPS system installers evaluating Sandpiper, Avocet and Swift GPS
receivers for navigation and positioning. This guide assumes the user has basic
computer skills and is familiar with Windows environments.

If you have any questions about installing or using
Conductor, please contact Axiom Navigation at:

Tel:  714-780-5900 (8 AM to 6 PM Pacific Time)
Fax: 714-780-0078

email: [support@axiomnav.com|



mailto:support@axiomnav.com




Introduction

About Conductor

Thank you for your interest in Axiom Navigation products. Conductor is a PC
based front-end for customers evaluating Axiom’s Sandpiper, Avocet, and Swift
12-channel GPS receivers. These receivers feature the SiRF chipset, which has
superb acquisition and tracking performance. Conductor can communicate with
these receivers using SiRF binary protocol, NMEA-0183 standard protocol, or
Axiom User1 protocol.

Conductor makes available all of the necessary information that can be retrieved
during the normal operation of a receiver. All aspects of GPS data (position,
velocity, time, satellite tracking, etc.) can be monitored and logged under various
test scenarios for evaluation of a receiver. Conductor allows analysis of the
collected data in order to investigate performance issues such as accuracy, road
test position and trajectory, satellite tracking, time to first fix, etc. All processed
data is in ASCII format and can be ported into popular spreadsheets (e.g..,
Microsoft Excel) for creating plots and statistics.






Chapter 2 Getting Started

Getting Started

This chapter describes the PC requirements and step-by-step instructions to
install the Conductor program using Windows 95, Windows 98, Windows 2000 or
Windows NT 4.

Software Requirements

These are the system requirements for running the Conductor program:
Microsoft Windows 95, Windows 98 or Windows NT 4 operating system
1 available communications (COM) port

9 MB available hard disk space

16 MB RAM (32 MB for Windows NT 4)

Pentium processor or equivalent

640 x 480 256 color display minimum, 800 x 600 16-bit color recommended
Note: for optimum display, set your display settings to Small Fonts.

Installing Conductor

To install the Conductor software on your computer, follow NOTE

these steps: If you have any

1. Insert the Conductor CD into the CD drive of your PC.

2. From My Computer, select whichever drive is the CD
drive (usually the D: drive).

3. Double-click on Setup.exe.

From there, you need only follow the prompts of the setup

previous versions of
Conductor installed on
your computer, you
should uninstall them
first. This can be done
with Add/Remove
Programs located in
the Control Panel.

program to install Conductor. The setup program will also walk you through the
process of setting Conductor's local options in order to initialize the receiver. Itis
not actually necessary to initialize the Sandpiper, Avocet, or Swift GPS receiver
since it will perform a cold start in less than a minute.

After Conductor has been installed, you can open it by choosing Conductor from
the list of Programs on the Start menu. Unless specified otherwise, Conductor
will be installed to C:\Program Files\Conductor.
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Il.

Using the Conductor

The Setup Wizard

Running Conductor for the First Time

The first time that Conductor is run on a new computer, there are a few things
that the program needs to know before it can begin normal operation. When you
first open Conductor, it will ask what serial port you will be using to communicate
with your receiver. Choose the correct port from the list of available COM ports,
and press OK. If there are no COM Ports available on your computer, then
Conductor will alert you of this problem.

Next, the main Navigation Display will appear, followed by a setup wizard to
guide you through the process of configuring the Conductor to your needs.

Selecting a Location

The first item that the setup wizard asks you for is your current location on earth.
This is used to help initialize the GPS receiver to its current location, resulting in
faster navigation. A small world map will appear, with crosshairs designating
where you are. You may choose from the list box of standard locations, or use
the mouse to drag the crosshairs to the approximate area where you are located.
When you have selected your location, press OK.

Selecting a Geodetic Datum Plane

TIP
To correctly calculate your position on the earth, the If the datum that

receiver uses a mathematical representation of the earth you are looking
called a datum. It is an ellipsoid that roughly approximates | for does not
the surface of the earth. Currently there isn’'t a datum that appear on the
works perfectly throughout the world. Therefore, there are | list. then you may
many different datums that each work well for their enter your own
respective location on the earth. The Conductor will ask ISR  CEI:
. See Using a

you to select a datum that best represents your region of C .

: ustom Datum in
the planet. Choose from the datums provided, and check Chapter 7.
to see that the region the datum is suggested to be used in
matches your region. The most general datum, which the
United States uses, is WGS-1984.




Chapter 3 The Setup Wizard

Checking the Time Zone

Next, Conductor will ask you to verify your time zone information. The offset from
Greenwich Mean Time is used to correct the clock information received from the
GPS receiver to the time zone that you are located in. Conductor will open up the
settings window used by your Windows operating system so that you can make
sure that the time zone that your computer is set to is correct. If it isn’t, be sure
and select the correct time zone for your area.

That’s It!

Now you should be ready to start using the conductor. As soon as the wizard
closes, Conductor will attempt to communicate with the receiver that is
connected to the communications port that you specified. It will automatically
begin detecting what message set is being used, using different options until
correct communication is established.
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4. Understanding Receiver Communication

What is a “Message Set?”

In order for the receiver to communicate its information to the PC, it requires a
Message Set that both the receiver and the PC will understand. Conductor
understands the SiRF binary message set, developed by SiRF Technologies,
and the NMEA-0183 standard GPS message set. Conductor also communicates
in the Axiom User1 message set, which is explained in chapter 16. Before
Conductor can begin to operate correctly, it must first figure out which message
set the receiver is using and the baud rate that it is being used.

Using Auto Detect

In the menu, the item File->Message Set->Auto Detect will enable or disable
the Auto Detect mode. If Auto Detect is checked Conductor will attempt to try
different message sets at different baud rates until correct communication is
established. While this is occurring the gauges on the Navigation window will
spin and move.

At the bottom of the window, flashing in red, is the status of the search. If it reads

“Please connect a GPS receiver”’, then that indicates that Conductor is not
receiving any data on the COM port at all. Check the Display 1/O icon to
see if it is flashing red. This is the light bulb located under the text
displays. If the light bulb icon is not flashing at all, then this is also an
indication that there is no data being received.

If the status flashing in red states “Attempting [message set] at [speed] baud”,
then Conductor is receiving data and is attempting to interpret it according to the
settings specified.

If Conductor fails to communicate with the receiver, then it will display a window
indicating this. Choosing abort will exit the program. Ignore will stop the auto
detect process, and retry will begin the process again. If Auto Detect continually
fails to communicate, then you may want to attempt to choose the message set
and baud rate manually.
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Choosing the Message Set Manually
Log Wiew

Change COM Paort...

The first thing you will want to do is
| disable the Auto Detect mode. In

Meszage Set

MMEA Meszage Set

Select Receiver Type v SiRF Binany Protocal

Agiom Uzerl Protocol

the menu, uncheck the item
File>Message Set->Auto Detect.
Next, you can choose which

Initialize Recelver

message set you wish to try in the
menu with either File->Message
Exit Set->SiRF Binary Protocol,
File>Message Set->NMEA
Message Set, or File>Message
Set->Axiom User1 Protocol.

Auto Detect

Reprogram R eceiver

About Conductor

I'f? X There are also tool bar buttons corresponding to these menu items.
See The Toolbar.

Selecting the Baud Rate

The GPS receivers can also communicate in different baud rates. To select the
correct baud rate for your receiver, open the options window with the menu item
File->Change COM Port....

Options x|

Log | Locali Display  Communications IWamingsI

— COM Port Option

Part lEDM 1 j The S_iHF Binary Meszage
Set will only operate at;

Mo Parity
Speed |384UU j‘ 2 Data Bits

1 Stop Bit
Parity INDne ‘l
Data Bits IS ‘I
Stop Bits |1 j" Set Receiver Serial Port I

Protocol Defaults...

Set Receiver DGPS Port I

Cancel | Apply |

On the window there are drop down boxes that you can use to select the correct
COM Port, baud rate, as well as other port settings. The information box on the

right indicates what are appropriate settings for that particular message set. The
standard baud rates for SiRF binary are 9600, 19200, and 38400. The standard
baud rate for the NMEA-0183 message set is 4800.
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Correct Communication

should see the message set status icon (the icon on the very left) change
to that message set, as well as the Data 1/O icon (the light bulb) flashing
yellow. The title bar also displays the current message and baud rate.

Q When Conductor is using the correct message set and baud rate you

Selecting the Receiver Type

Conductor has the ability to communicate with the SiRFStar | chipset-based
Sandpiper and Avocet line of receivers as well as the Swift receiver, which is
based on the SiRFStar Il chipset. Normally, Conductor will automatically
determine which type of receiver it is connected to and only display the
commands and options that are available with that receiver. In some cases,
however, Conductor will be unable to automatically determine the receiver type.
In those cases, the message box shown below will appear asking you to
manually select the receiver type. You may also chose to manually select the
receiver type at any time by choosing the File>Select Receiver Type menu
item.

. Select Receiver Type |

Select Receiver Type. ..

‘ SandPiper, fwocet [SIRFStar ] I

Swit (SiFFStar 1] |
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5. Understanding the Navigation Display

The Navigation Display is the primary display screen that Conductor uses. It
displays all of the standard information that is provided by the GPS receiver. You
will see your current latitude, longitude, altitude and velocity, as well as your
position on the earth, and the satellites that the receiver is currently tracking.

onductor [COM 3: 5iRF Binary @ 19200)

File Log ‘isw Digital Time
Tool bar : = : /| and Date
[t 1[5 Bix e 2 /= 2l ele ] &0 2 / ety
I\T:v%zrtli%il | 033.788676° Lattucs - &M [GPS)
Information |'117 .790769° Longiude Noembes 25, 2000 Graphical
Display | |[i28.16-m e 0y Heading
0.1 m/s ¢ 136.4° Ve | ISplay
Operating Graphical
Status Display M 8 %’ 5@ @ Speed Display
200 — ALT
Graphical . Graphical
Altitude Displa it . ,
play ﬁj “,E!EI" Position Display
Latitude - 50: _
Longitude - / S_altelllte Status
X-Y Plot = 40 40 Display

Status Bar

The Tool Bar

I_ s B x| ([l =] <)<= alslefe ] #(O%| _|

2 34 56 7 8 910 11 12 1314 1516 17

1. Enable/Disable Conductor Deselecting this button will disable all
communications with the GPS receiver, freeing up the COM Port.

2. SiRF Message Set Switches the Conductor to the SiRF binary message format
and sends a command to the receiver to switch to SiRF binary mode.

3. NMEA Message Set Switches the Conductor to the NMEA-0183 message set,
and sends a command to the receiver to switch its message set to NMEA.

4. Axiom User 1 Message Set Switches the Conductor to the Axiom User1
message set and sends a command to the receiver to switch its message set to
Axiom User 1.
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5.

10.

11.
12.

13.

14.

15.

16.
17.

18.

Log Data Starts the Conductor logging the data that is specified in the Logging
Options window. See Logging Data.

Log Errors Starts the Conductor logging the errors that are occurring with the
receiver. See Logging Errors.

Log Debug Starts the Conductor logging the Development/Debug Data that is
displayed in the Debug Window. See Logging Debug Data

Channel Status Opens the Channel Status display. See The Channel Status
Window.

Command Window Opens the Command window. See The Commands
Window.

Information Window Opens the Information display. See Receiver Information
Window.

Status Window Opens the Status display. See The Status Window.

DGPS Status Window Opens the DGPS Status display. See The DGPS
Status Window.

Messages Received Opens the Messages Received display. See Monitoring
Output Messages.

Development Data Window Opens the Development Data display window,
which displays a readout of the development messages that the receiver outputs.
See The Development Data Window.

Trickle Power Displays a window for enabling the Trickle Power functions of
power saving GPS receivers. See Trickle Power.

Time Window Opens the Time control panel. See Setting the Time.

Initialize Receiver Sends a command to initialize the GPS receiver to its
current time and position. See Initializing the Receiver.

Options Opens the Options window. See Changing Display Options.

Numerical Navigation Information Display

This display offers a detailed description of the GPS receiver’s current position,
altitude, heading, and speed. The units can be changed in the Options menu.
(See Changing Display Options.)

Digital Time and Date Display

Large and red, the Digital Time Display is an easy indication of GPS receiver
operation from anywhere in the room. Once the GPS receiver acquires at least
one satellite, then it will output time information to Conductor. The time is
adjusted from the receiver's GMT (Greenwich Mean Time) zone using the local
GMT offset. (See Changing Local Options.)
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Operating Status Display

These boxes display information about the Conductor and the GPS receiver's
operation. The following table shows all the possible icons that may appear in
each box and their meaning.

Table 3.1 Operating Status Display Icons

- T ;
37 &)
Message Set J -
SiRF Binary NMEA-0183 User1 Unknown
Data I/O Q @ ’ @
Status Receiving Data Not Receiving  Error Received Conductor
Data Disabled
Navigation 8 g g
Qualit .
v Good Navigation ~ Poor Navigation = Bad Navigation
e & &
WSS +en <im0 BEASE
DGPS Status ; =l-Hm var i
DGPS is On . . : Receiver in
AndUsing ~ DCPSISOn  DGPSis Off - Dolg Cold g, 0 s1a0n
WAAS Mode
Solution % ED °
Status
3-D Solution 2-D Solution No Solution
S——— @ o
Reply —
No Reply Acknowledged  Unacknowledged NMEA Messages

@ﬁ Message Set
o

This box indicates the current message set that is being used to communicate
with the GPS receiver. For the Sandpiper/Avocet and Swift receivers, this will be
the Axiom User1 message set, the NMEA-0183 standard, or the SiRF binary
protocol, which exchanges more extensive information with the receiver. Double-
clicking this icon will display the receiver's software version and the software

build time and date.
)

a‘ 5o A small red question mark next to the message set icon indicates that the
software version or Axiom Variant version differs from the values that have been
set in the Warnings tab of the Options window. See "Changing Warning
Options", chapter 11, for more information on how to set these options.

11
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Q Data I/O Status

This box lets you know when the receiver begins to
receive data from the satellites, and when the data
has been cut off. The Error Received red light
illuminates when data that has been received fails its
own checksum. Double-clicking on this icon will
show the last error generated.

3 Navigation Quality

TIP
More detailed information
about each icon in the
Operating Status Display
can be obtained by holding
the mouse cursor over the
icon for a few seconds. A
fly-by message will appear
with additional information.

The traffic light shows how many satellites are being used in the navigation
solution (not how many satellites the receiver is tracking). A red light means
either that the receiver is waiting for satellite clock and ephemeris data or has
insufficient pseudoranges to navigate. A yellow light indicates that it has enough
pseudoranges for 2-D navigation, while a green light indicates that is has enough

for 3-D navigation.

fég DGPS Status

Whether or not you are receiving DGPS signals can be seen by a glance at the
fourth box. A special icon is displayed if WAAS is the source of the DGPS
corrections. Sandpiper, Avocet, and Swift automatically use DGPS information if
it is received. Alternatively, this box may show that the receiver is performing a
cold start. If Conductor is in reference receiver mode, the Base icon is displayed.

(See Using the Detail Windows, Commands.)

% Solution Status

This box shows whether the receiver has a navigation solution and whether the
solution is 2-D (giving latitude and longitude) or 3-D (latitude, longitude and

altitude).

@ Command Reply Indicator

While using the SiRF binary message set, any time a command is sent to the
receiver, the receiver replies with either an acknowledgement that the command
was received and executed, or an unacknowledgement, implying that the
command was invalid. These responses are indicated by a green and red light,
respectively. If a green light flashes after you send the receiver a command, then
you can be sure that the receiver accepted and performed your request. If a red
light flashes, then you need to check the parameters that you sent with the

command and try again.

12
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When the Conductor is receiving NMEA-0183 messages, this icon will display an
NMEA icon. The NMEA message set does not respond when a command is
sent.

Graphical Altitude Display

The altitude bar scale can be modified using the display options. (See Changing
Display Options.) Non-Differential GPS altitude typically fluctuates £100 meters.

Latitude - Longitude X-Y Plot

This is a simple X-Y plot of Latitude and Longitude. Although there is no map
underneath, Conductor keeps track of the receiver's movement from the starting
point. If you are stationary, you can see the S/A errors that the Department of
Defense puts into civilian GPS signals. By default, the view area is 40 meters by
40 meters. The scale can be changed using the TIP

display options. (See Changing Display Options.) To clear. or refresh
Conductor by default stores the last 500 data points  |the X-Y Plot display,
(seconds) in memory, and these are replotted click the right mouse
whenever the display is refreshed. You can button, and choose
manually refresh the plot or clear the memory buffer  |from the menu.

using the right mouse button on the display.

Graphical Heading Display

The arrow points in the current GPS heading, with North fixed at the top. With
this compass, it is easier to see the heading at a glance, rather than translating
from the numerical heading display where 0° indicates North, 90° is East, etc.
When the receiver is not moving in any direction it is difficult to determine its
heading. Therefore, unless the receiver is in motion, the heading information is
unreliable.

Graphical Speed Display

This simulation of an automobile speedometer indicates the GPS rate of travel.
The units can be modified using the display options. (See Changing Display
Options.)

World Map Display
This map of the world gives a rough approximation of the GPS solution
calculated by the receiver. If it has not yet calculated a solution, it shows the

initial position that the user has sent to the receiver. The default position is 0°
latitude and 0° longitude, which is just off the Gold Coast of Africa. This map is

13
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for display only, although it's similar to the map used to change your current

location. (See Changing Local Options.)

Optionally, the approximate locations of the satellites that
are being tracked are displayed on the world map. The
satellites’ locations are calculated as if they were in space
directly above you, and are not corrected for the curvature
of the earth. The farther a satellite is from the center, the
closer it is to the horizon. Labeled on each satellite picture
is its identification (PRN) number.

Satellite Status Display

TIP
To quickly show
or hide the
satellites or the
crosshairs, click
the right mouse
button on the
world map

The black bar at the bottom of the Conductor display indicates the number of
satellites currently being tracked by the receiver. The satellites are ordered by
channel, ranging from 1 to 12. A channel successfully tracking a satellite
displays the image of a satellite. If a channel is actively searching the sky for a
satellite, but has not found it yet, that satellite appears with a question mark (“?”).
Unused channels appear blank. Though most receivers have the ability to track
12 satellites, frequently only 6 to 8 satellites will be visible at any specific time.

Signal Level

Satellite ID
<4

Optionally, you can also have the signal strength of each
satellite displayed here as either SNR (Signal-to-Noise
Ratio) or C/No (Carrier—over—Noise Ratio). (See Changing
Display Options.) By default the signal strength is displayed
graphically, with weak satellites showing only dimly while
strong satellites are shown brightly. Alternatively, the exact
SNR or C/No value, as well as the satellite’s identification
number for each satellite can be displayed as text above
and below each image.

TIP

Fly-by information is also
available for each
satellite image. Hold
your mouse cursor over
one for a few seconds.
Also, holding the left
mouse button on a
satellite will show a
detailed run down of that
satellite’s status. (SiRF
message set only)

To quickly change what is displayed in the Satellite Status Display, click the right
mouse button on the satellites, and a menu will show the different options.
Please note, if you choose Hide, then the display will disappear. To get it to
return, you must enter the Options window (View->Options), and select the

check box next to Satellite View.
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Changing Communications Options

Options |

Log I Local I Display ~ Communications |Warnings|

— COM Paort Optionz

Puart IEEIM 2 j The SIRF Binary Message
S et will anly operate at;

Speed m Q%Eﬁ-.'“e’”ns
s Im 1 Stop Bit

Data Bits IE vI
Stop Bits I1 vI Set Receiver Serial Part |

Set Heceiver DGFS Port |

Pratacal Defaults. .

Cancel | Apply

In order to communicate with a GPS receiver, Conductor must have the correct
Communications Port settings. By default, the Conductor tries to automatically
set these settings for you. In most situations, only the COM Port and the Speed
should be changed. Changing the other properties may inhibit good
communication.

Only the COM Ports that are available on your computer will show up in the COM
Port drop down list. If a COM Port is not listed, then another device in the
computer is using it.

Each message set has its own communications settings that are stored
independently of one another. The settings displayed are only those used for the
current message set. The information box supplies the parameter requirements
for the message set that you are currently using. The SiRF binary message set
uses 9600, 19200, or 38400 speed as its standard. The NMEA-0183 standard
uses a standard speed of 4800.

Setting the Receiver’s Port Options
Pressing the buttons marked Set Receiver Serial Port, or Set Receiver DGPS

Port, each send a command to the receiver that will change the receiver’s
communication settings for the main serial port, or the DGPS port, respectively.

15
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Setting the Default Communications Settings

Pressing the Advanced... button will open this window:

: 51IBF Receiver Defaults

Baud Rate [EEN

I ME.-’-‘-. Defaultz [SIRF Receivers Only)

Dutput B ates: I GEA [ i'!

TS
[Gsa s =
[esve =
==
i

~ SiRF Defaults

Baud Rate |3500 =l
Ok Cancel

This window sets the default setting that
are used when switching back and forth
between the SiRF message set and the
NMEA message set. When you select the
menu items or the toolbar buttons that
switch the receiver’s message set, then
these settings will be used to switch
them.

The baud rates entered here will be used
as the standard baud rates for general
switching. Also, the NMEA messages
and their respective rates can be chosen
to customize to your own personal needs.
Each rate represents the interval in
seconds that the message is output by
the receiver.

These settings will only take place when

the message set is changed in the navigation window, either from the menu or

the tool bar.

16
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Chapter 7 Changing Local Options

Both for initialization and display purposes, it is important that Conductor be
aware of the attributes of your local area. The first time that Conductor is run, an
Initialization Wizard will walk you through the process of setting Conductor's local
options. Afterwards, it is sometimes necessary to send the information to the
GPS receiver. You can also modify these settings by choosing Options from
Conductor’s View menu, and clicking the Local tab.

[ 1| | oca/ Position

Log Local |Display| Eummunicatinnsl Warningsl

With the proper

— Local Operating Parameters !ocatlon )
information,
— Local Poziton———— 1~ Local Datum Conductor can
Select Location... | Select Daturn... merm the_recelver
T e 7 of its location to
atitude ocal Latum Mame speed up the initial
{33825 |wGs 1984 search for
Longitude satellites. You may
[-117.916 ~Time Zone manually enter
Allitude Windows Settings. . .your IOPatlon here,
[0 in fractions of a
Local GMT Offset degree, or click
Send to Receiver | I? Select Location to
find your position
on a map.
Cancel | Apply

Finding Your Position on the Map

Select Location

Location Ryt =

Ok I Cancel

A number of approximate locations
are listed above the map. By
choosing the closest one of these
default positions, you will get close
enough for satellites to be found.

Alternatively, you can click the
mouse directly on the map to point
to your location. This will give a
good approximation of your
latitude/longitude position. Click OK
to update the Local Options
screen.

17
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Local Datum

A datum is a mathematical approximation

2 of the surface of the Earth. Many countries
G=0aslic Bialim lane use different datums to best approximate
e T the surface of the Earth in their location.
Region The United States uses a datum named
[Glabal Definitian WGS-1984. Click Select Datum to choose
Ellpsaid the datum for your location.
[wis 84 e
Semi-major Flattening Selecting a Datum
|Bars1a7 |298. 2572236
219 datums are available in the drop-down
e L e list on this window. Information about the
I I I selected datum is also displayed including:
Satelite Measurement Stations: [T the mathematical ellipsoid employed and
how the solutions using this datum differ
ok | caesl || from WGS-84, in meters. Click OK to

update the Local Options screen.

Using a Custom Datum

*Advanced Users Only!

A custom datum definition is currently available with Conductor using any SiRF
compatible receiver. Select “Custom Datum” from the list of datums. You can
either use a predefined ellipsoid, or select “Custom Ellipsoid” to define your own.
Input the X, Y, and Z differences in the boxes provided. Press OK to put the
datum into use. Warning! Using a custom datum without proper knowledge of
the input values may have unpredictable results. Use with caution.

Local GMT Offset

GMT stands for Greenwich Mean Time, or the time zone “zero” over Greenwich,
England. The local GMT offset is the number of hours subtracted from GMT to
get the correct local time. For example, Pacific Standard Time (PST) is GMT - 8
hours, or an offset of 8. The time in Seoul, Korea is GMT + 9 hours, or an offset
of -9. The GMT offset will never be less than —12 or greater than 12.

Conductor will open your time zone settings window that is provided with the
Windows operating system when you press the button marked Windows
Settings.... Conductor uses this setting to get the GMT offset.



8. Setting the Time

It is important that both your computer and the GPS receiver use the correct
time. This window facilitates that. You can reach the Set Time window by

clicking the time tool bar button on the Conductor's Navigation Display, or by
choosing Set Time from the View menu.

#F Set Time !IE

Chapter 8 Setting the Time

Click to set the
receiver’s internal

Click to set the ~GPS Time ok sing fimne f
computer’s (PC) [10.38.52 clock using time from

internal clock to
exact local time

12/07 /93

Send to Computer |

the computer’s (PC)
internal clock.

4
based on UTC. //
— Computer Internal Clock,
10:38: 08 / Enter a new custom
12/07 /05 R time different from
both the receiver and
Click to set the - Mew Settings - the computer.
computer’s internal o zf38 zfoz - Send to Computer

clock to the new

[12 207 2

Click to set the

custom time. Send to Beceiver receiver’s internal
clock to the new
The local custom time.

GMT offset.

Cloze

Local GMT OFfzet [8

It is critical that the GMT offset be correct to translate the time between the
computer’s internal clock (which uses the local time zone) and the receiver’s

internal clock (which uses GMT).

An alternate way to set the receiver’s time is to push the Initialize GPS toolbar

button on the Conductor's Navigation Display. This button will only work
il properly if the GMT offset is correct. The button also sends position
information at the same time.
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9. Changing Log Options

Data, debug, and error logging can be
switched on and off via the Log menu, or
their respective tool bar buttons on the
Conductor's Navigation Display. The
detailed options below are obtained by
selecting Options from the Log menu.

TIP
Holding the mouse over a
logging toolbar button will
show a flyby with the number
of lines logged so far.

I_% 4
GGING DATA: 8 lines wiitten to file.|

Options

Log |Ln:n::a| I Displa_l,ll Eammunicatinnsl Warningsl

]|

—Data Log

[ Speed [m/s]
[ Heading
1 B sba ik Trnde LI
[~ Tab Delimited ¢ Append ¢ Replace ™ Limit File Size
Filename |DevLu:ug.t:-:t Browse. .. |
—Emor Log —

" Append (¢ Replace [ Limit File Size

Fil=name |Erru:urL-:ug.t:-:t Browse... |

—Debug Log

™ Append (¢ Replace [ Limit File Size

Filename |Del:uugLu:ug.t:-:t Browse. .. |
k. Cancel | Apply
Types of Logs

El Logging Data

Select Data from the Log menu to begin logging GPS navigation information

once settings have been applied. Any and all of the data shown in Table 9.1 can

be logged.
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Table 9.1 Possible data logging parameters

Parameter Contents
Date Date from the receiver
Time Time from the receiver
Position Current 3-D position

(latitude, longitude and altitude)

Speed In meters/second
Heading In degrees
Rate-of-Climb In meters/second
DOP Geometric dilution of precision
SVs Tracked Number of satellites tracked
Navigation Mode None / 2-D Navigation / 3-D Navigation
Track Mode Cold Start/ No DGPS / DGPS
Channel Satellite The ID of a tracked satellite, one for each channel
Channel SNR or C/No The signal strength of each channel
Channel State The tracking status of each channel

M Logging Errors

Check the Log Errors box to begin logging Conductor processing errors when
settings are applied. Errors mostly include communications errors relating to bad
data received or data that cannot be processed.

EI Logging Debug

The debug logging function is intended for GPS engineers to have the ability to
log the output of the Debug window. Development messages are continually
outputted by the Sandpiper and Avocet receivers. These sentences contain
information about the current operations of the navigation engine.

Using the Logs

Format

Each log is written sequentially, with every entry ending in a line break. Error
and Debug logs contain variable types of data in each entry, while Data logs
have a fixed number of fields in each entry. Data log fields are separated by
tabs, and each file begins with a row of headers for each column. Data log files
are easily imported into spreadsheet programs like Microsoft Excel.
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Limit File Size rTET———
<+ Limit File Size
Checking Limit File Size on the Log
Options tab tells Conductor to Lirnit log file ba |32|:||:||:| lines long.
automatically stop logging or create a o T s el

new file when a log reaches a defined
number of lines. A line is a single
record and varies in the number of & Start a new file.

bytes it contains. Conductor creates Auta-numbering starts at I'I

additional filenames by auto-
; Cancel |

" Stop Logging.

numbering them starting from a
specified number.

Stopping a Log

To stop a log, uncheck the type of log (Data or Error or Debug) from the Log
menu, or deselect its respective tool bar button.
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Changing Display Options

Much of what you see on the Conductor's Navigation Display can be modified in
some way. Choose Options from the View menu to access these options.

Options |

Log I Local Display | Eammunicatinnsl Warningsl

— Unitg —Gauges
' Time [z
'4DE:; 'ﬁin <] %4 Plot Sample Size  |500
tJL . 'wiidth [m] Height ]
T %Y Plot Area | 100 100
Deq. Min. Sec. j
i b iry b o
e Altimeter (f] |0 200
IFeet j
Speed [ED

i a0
I mph j Speedometer  [mifhi]

—Animations
¥ Commands [ Detecting

v Satellite Wiew
" SHNR |V Graphical
@ LMo ¥ Satelite ID | —'wiorld Map

[+ Signal Level v Satelites ¥ Cross hais

k. Cloze

Units and Gauges

The units in which GPS navigation information is displayed can be changed to a
variety of formats. Also, the bounds of the display gauges can be modified here
as well. Keep readability in mind when entering values for gauge bounds.

SNR or C/No Display

The signal strength can be displayed with one of two different units: Signal-to—
Noise Ratio or Carrier—over—Noise Ratio. Signal strength can be represented on
the Conductor's Navigation Display in two ways. Graphical means that the
satellite images fade with decreasing signal strength. Signal Level means that
the exact SNR or C/No is printed on the upper left corner of the images.
Checking Satellite ID will cause the satellite’s identification PRN to be displayed
in the lower right corner.
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World Map Settings

Selecting Satellites will display the approximate locations of the satellites in the
sky in relation to the receiver’s position. Selecting Crosshairs will display the red
crosshairs that identify the receiver’s location.

Animations

Conductor employs certain animations which enrich the user interface. The
animations, however, may not be necessary to some users, and may even slow
down the operations of Conductor on slower computers. If you find that the
speed of Conductor is slowed considerably by these animations, you may want
to disable them. The Detecting animation is displayed when no GPS data is
detected on the COM Port, and Conductor is AutoDetecting the message set and
baud rate. The Commands animation is the gradual resizing of the Send
Commands window when different commands are selected.
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Changing Warning Options

Conductor may be configured to give two types of warnings when certain
conditions are met. This window is used to set the conditions under which
version warnings will be given. The settings you make on this window will be
retained on program shutdown and used the next time the program is started.

ptions |

Log I Local | Displa_l,ll Communications  #farnings |

— Saofhware Werzion Warnings

I~ “wharn if receiver software version does nat match the
[ollowing: [1.31DKIT144

¥ wiamm if &xiom ariant version does nat match the: following:
|D20sEL

— Unknown Yersion W arnings
¥ Show question mark icon if software version is unknown,

¥ Show question mark icon if Sxiom Yaniant version i unknown,

Software Version Warnings

The Software Version Warning checkboxes determine whether you will be
warned (by a pop-up message) whenever Conductor determines that the
software version or Axiom Variant version of the receiver that you are currently
connected to differs from the software version or Axiom Variant version that you
entered in the text boxes on this window.

Unknown Version Warnings
Checking these boxes will cause a small red question mark to be displayed just

to the right of the Message Set icon if the receiver software version or Axiom
Variant version is unknown.
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12. Using the Detail Windows

To open a detail window, select it from the View menu on Conductor’s

28

Navigation Display.

The Commands Window

|
ER I [ | O /\dvanced Users Only!

Cornmand: |Inilialize

=] 3 The Command
window may be

Time

|lzed to Initialize the Receiver with the Current Position and

opened by pressing the icon
on the toolbar, or by selecting
View2>Commands in the

ECEF ¥ |

menu bar.

ECEFY |

The Command window is a

ECEFZ |

simple and flexible way to

Time of Week I

send all possible commands

Wwieek Murmber I

to the GPS receiver. Simply

Channels |12

choose the command you
wish to send, enter any

Reset Canfig. |33

necessary parameters, and

Clock Offset |75000

click Send. A helpful
description is provided with

Claze | each command, as well as

TIP
Hold the mouse cursor over
a Parameter to see its
description and boundaries.

flyby tips on each parameter
giving a description of it.

Different commands are available for the SiRF
message set, the NMEA-0183 message set, and
the Axiom User1 message set. There are also
additional SiRF commands available when using
the Swift receiver.

NOTE- If you are running on a slower computer, you may want to disable the
resizing animation. See Changing Display Options.

SiRF Message Set Commands

The following commands are available when using the SiRF Message Set:
1. Initialize: Resets the receiver using initial position information that is based
on the Earth-Centered Earth-Fixed (ECEF) coordinate system.

2. InitializeLLA: Similar to the Initialize command but the initial position is
expressed in terms of Latitude, Longitude, and Altitude.
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11.

12.
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Protocol: Sets the serial port protocol to one of the following modes: SiRF
binary, NMEA-0183, ASCII, RTCM, or User1.

Switch to NMEA Protocol: Switches the receiver into NMEA mode at the
specified baud rate and allows you to set the output rate of the following
NMEA messages: GGA, GLL, GSA, GSV, RMC, and VTG.

Software Version: Polls the receiver for its software version. The software
version is displayed in a pop-up message box. Note: it is also possible to get
software version information by double-clicking the Receiver-Type icon on
Conductor's main screen.

Clock Status: Displays the following GPS
clock status information in a pop-up message
box: GPS week, GPS time of week, estimated
GPS time, clock bias, and clock drift.

Clock Status E

@ GPS Week: 1060

GPS Time of ‘Wesk: 142340 45
Est. GPS Time: 142340458
Clack Bias: 12141853

. . , Clack Dt 103111

Main Serial Port: Allows you to set the main

serial port (port A) communication settings
(Baud Rate, Data Bits, Stop Bit, Parity).

DGPS Serial Port: Allows you to set the DGPS serial port (port B)

communication settings.

Mode Control: Several factors that control

the operation of the GPS receiver can be
set by using this command. They are: 3D At Constraint Mode: Enablad
Mode, Altitude Constraint Mode, Degraded i:tmj ';'Dde: *’L‘“‘f‘
. . a ource:; a3
Mode, DR Mode, Altitude, Altitude Hold A .
Mode, Altitude Source Mode, Coast . .
Timeout, Degraded Timeout, DR Timeout, Deaieded Mode: T hen i
. Degraded Timeout: 30 zec
and Track Smoothing.
. . . DF Timeout: 20 zec
Poll Receiver Parameters: Sending this Track Smaath Mode: Enabled
command will result in a window appearing DOP Mask Mode: Disabled
that fjisplays the current sett.ings of va.rious DEFS Made: Ao
receiver parameters. (See right). This DGPS Timeout: 30 sec
window is a snapshot of the state of the
receiver parameters at the time the Sk Etlos Loitue
P _ . Maw Power Mask: 30 dBHz
command was issued and is not -
automatically updated when you change Edit Residual Threshaold: 10000 meters
| Steady Detect Threzhold: 0.5 mds
parameter values. Static Nav Thieshold: 0.5 m/s?
Poll Ephemeris Data: Requests the Low Power State: Continuous Track
receiver to send its current ephemeris data Low Power Duty Cycle: — 100%
to the specified file. The data is stored in LeuRouenlnfims s Ois

binary or text format depending on the file

. Aeceiver Parameters E

output format you select. You may request ephemeris data from a single
satellite by entering its number in the SV ID parameter box or from all

satellites by entering 0 in this box.

Set Ephemeris Data: Reads ephemeris data for a particular satellite from
the specified binary or text file and sends it to the receiver. The successful

29
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13.

14.

15.

16.

17.

18.

19.

20.

21

22.

23.

reception of this message will be indicated by illumination of the green
acknowledge message light.

Poll Aimanac Data: Requests the receiver to send almanac data for all of
the satellites to the specified file. The data is stored in binary or text format
depending on the file output format that you select.

Set Almanac Data: Reads almanac data from the specified file and sends it
to the receiver. The input file should contain a complete set of almanac data
(32 entries) appended to each other in a binary or text file. The successful
reception of this message will be indicated by illumination of the green
acknowledge message light.

Steady State Detection: Sets the threshold for steady state detection. Enter
0 to disable this feature.

Editing Residual: Sets the editing residual threshold. Enter O to disable this
feature.

Static Navigation: Sets the threshold for static navigation. Enter O to disable
this feature.

Elevation Mask: Sets the navigation elevation mask angle. The valid range
is from -20 to 90 degrees.

Power Mask: Sets the navigation power mask in dBHz. The valid range is
from 20 to 50 dBHz.

DGPS Control: This command is used to instruct the receiver to ignore
DGPS corrections ("Never"), to output position fixes only when corrections
are available ("Exclusive"), or to use corrections whenever they are available
("Auto"). The Time Out parameter sets the acceptable age limit of the DGPS
corrections. In exclusive mode, the receiver will not output position fixes if
they are based on out of date corrections. When DGPS corrections are out
of date in auto mode, the receiver will still continue to output position fixes but
they will be without differential corrections.

. DOP Mask Control: Sets the Dilution of Precision (DOP) mode and the

threshold values for GDOP, PDOP, and HDOP.

Set Operating Mode: Sets the receiver into test mode for the length of time
specified. The number of the satellite to be tracked must also be specified.

Trickle Power: Sets parameters for those receivers that have the capability
of being placed into trickle power mode. If Push To Fix is not selected and
the Duty Cycle is set to a value greater than 50%, the receiver will be placed
into Continuous Track mode. Trickle Power parameters can also be set by
using the window that appears by pressing the Trickle Power toolbar button.
(See chapter 13, Trickle Power).

Additional Swift (SiRFStar Il) Commands

24.

Set DGPS Source: Sets the source for DGPS corrections. Valid sources
are: None, WAAS, Serial Port B, and Internal Beacon Receiver. When the
source is set to Internal Beacon Receiver, you should also enter values for
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the Frequency and Bit Rate to be used. Setting either of these values to 0
causes the receiver to automatically scan for the proper value to use.

25. Set Message Rate: Allows you to set the output rate to be used for various

messages from the receiver. Set the Poll Now parameter to 1 to force the
receiver to output the specified message immediately.

26. Set LP Acq Params.: Sets the maximum off time and maximum satellite

search time to be used during low power operations.

NMEA Message Set Commands

The following commands are available when using the NMEA message set:

1.

Switch to SiRF Binary: Switches the receiver into SiRF Binary mode at the
specified baud rate.

SiRF: Initialize ECEF: Switches the receiver to SiRF binary mode and
initializes the receiver using initial position information that is based on the
Earth-Centered Earth-Fixed (ECEF) coordinate system.

SiRF: Initialize: Similar to the "SiRF: Initialize ECEF" command but the initial
position is expressed in terms of Latitude, Longitude, and Altitude.

Set Datum: Sets the datum plane to be used. The Local tab of the Options
window provides another (easier) way of setting the datum to be used. See
chapter 7, Setting Local Options, for more information.

SiRF: Set Serial Port: Sets the protocol, baud rate, data bits, stop bits, and
parity for the main serial port.

SiRF: Set DGPS Port: Sets the baud rate, data bits, stop bits, and parity for
the DGPS serial port.

SiRF: Message Control: Sets or queries several parameters for the
following NMEA messages: GGA,GLL, GSA, GSV, RMC, VTG. These
message parameters can also be set by using the NMIEA Message Control,
described in Chapter 14.
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The Channel Status Window

;aﬁ The Channel Status window may be opened with the tool bar button or
_| by selecting View2>Channel Status from the menu.

% Tracker Data =10l x|

Channels l Measurernent Data I DGPS Data | 5V State Data I

i 2 E 4 5 5 7| ] g 10 11 12
Satellite 1D 1 28 13 19 4 0 0 L@ 22 20 2 25 0
State(Hes) |EF  |BF  [BF  [BF  [BF 0 O|ER [ - i
Azimuth 333 141 306 255 3045 0 0 795 207 2445 525 0
Elew 57 51 34 435 11.5 0 0 435 75 21 17 0
CNol1) 45 45 45 45 37 1 0 47 44 42 43 0
CNol2) 4E 4 45 4E 38 0 0 47 44 42 43 0
CNol3) 45 45 45 45 37 0 0 47 44 41 43 0
CNol4] 48 45 45 48 37 0 0 47 43 ] 43 0
CNol5) 4E 45 45 4E 37 0 0 47 44 42 43 0
CNolB) 45 45 45 45 37 0 0 47 44 42 43 0
CNol7) 48 45 45 48 37 0 0 47 44 42 43 0
CNol8) 4E 45 45 4E 37 0 0 47 44 42 43 0
CNol9) 45 45 45 45 38 0 0 47 44 42 44 0
CNo[10) 48 45 45 48 36 0 0 47 43 43 43 0
Average CNo 4 45.6 45.6 4 37.1 0 0 47 438 419 431 0

The Channel Status window displays detailed information about the status of
each of the receiver’s 12 channels. For more information about what each field
means, see Measured Tracker Data in the manual for your GPS receiver.

The State row displays a color corresponding to how many locks are performed
on a channel. A red channel has not had a bit sync lock or a frame sync lock.
Yellow has a bit-sync lock, but not a frame-sync lock. The color green shows that
the channel has fully locked and tracking. A channel that has lost its carrier lock
will show a darker green color.

If a receiver is using the SiRF binary message set and is outputting Raw Tracker
Data Messages, then you can view the Raw tracker Data by double-clicking
anywhere on the window. The window will reinitialize itself to display the
information in the Raw Tracker Data message. Raw Tracker messages contain
much more information about a certain satellite. However, it is intended for GPS
engineers, and may be difficult to understand. For more information see Raw
Tracker Data in the manual for your GPS receiver.

The information shown on the Measurement Data, DGPS Data, and SV State
Data tabs are only available when you are connected to a Swift receiver.
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Receiver Information Window

¥ Receiver Information Hi=] E3

Namel WYalue
ECEF = -24833266
ECEF Y -4626871
ECEF £ 3530388
Welocity on 0
Welocity an ' 0
Welocity on 2| 0
M avigation Mode 4
Status Mode 2
GPS Week | 987
GPS Time of Week 15307293
DOF 1.4
Satelites In Fix 8 e

Mavigation Data -

Clock Status
2 TP T hema imbma b LI ElDSE

To display the Receiver Information window, press the icon in the tool bar, or
El select View 22GPS Information from the menu.

This window displays all of the information that a receiver is
communicating, except for the channel status information. Each item on the main
chart represents a field in the current message set that contains information. The
left column contains the name of that item, and the right column contains its
current value.

The list box at the bottom of the window allows the user to select which
categories of information are shown. Each category represents a different
message that is received from the receiver. Check each item that is to be
displayed, and uncheck the unnecessary items.
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Status Window

15[
—Mode 1 [Mavigation]————— — Mode 2 [FOM]
M avigation Mode [~ DR Senzor Data Uszed
[Full 30 Navigation W Validated / Unvalidated
[~ DGEPS Used [T Dead Reckon Timed Out
[~ DOP Mask Excesded [~ Output Edited by LI
[ Trickle Power
Altitude Mode

|
Bl i 3

% The Status window may be displayed by pressing its toolbar button, or
selecting View 2>Status Window from the menu. It is only available in the
SiRF binary mode.

This window displays the details contained in the Navigation mode, and the FOM
mode that are outputted in the SiRF binary message set. It also shows the
number of satellites that the receiver is using to calculate its position.
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DGPS Status Window

& DGPS Status ME E
Saurce: IWMS
v 3 [ e ] s | 17 [ & | 2 | 2z | 2 | . | wa [ ma | N

Comectior:[ +16.03m | -7.76m | -F82m | 13.88m | -2336m | 1652m | -21.27m  +2802m -BOEITm| N A, MR

el R E e acar Hecener

Locked: IND Frequency: ID kHz [Manual] Bit Rate: ID bpsz [Marnual)
Signal M agnitude: ID Signal Strength: ID SMR: IIJ

The DGPS Status window may be displayed by pressing its toolbar
@ button, or selecting View 2DGPS Status Window from the menu. It is
only available in the SiRF binary mode when connected to a Swift
receiver.

This window shows the current source of DGPS correction data as well as the
actual correction values that are being applied to each available satellite's
navigation data. When DGPS corrections are being received from an internal
beacon receiver, the text boxes on the lower half of this window will become
active to show information that is relevant to that source of DGPS corrections.
The word "Manual" in the Frequency and Bit Rate text boxes indicate that these
values were manually set by the user. If these values were derived automatically
by the receiver, then "Auto" will be shown after the values in these boxes.
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Monitoring Output Messages

P Messages Received - o ] |

36

Meazured Mawvigation D ata
Measured Tracker Data
Raw Tracker Data
Sioftware Yersion

Clack Status

CPU T hroughiput
Acknowledgement
Hacknowledgement
Yizible List

Almanac

E phemeris

True Mavigation D ata

CeeereEEEOOPRPOO

True Tracker Data

Ceobeerreebe®

(@

ML Meazurement Data
ML DGPS Data

ML 5% State D ata

ML [ritialization Dats

50 BPS Subframe [ ata
Errar

Test Mode Data

Raw DGRPS

0K To Send

Suiarn Faw Tracker Data

lonospheric D ata

Development Data

IE To display the Messages Received window, press the icon on the tool bar, or
select View 2Messages Received from the menu.

GPS Receivers output information to Conductor using a series of messages that
contain different classes of information. The Messages Received window
displays a green LED light whenever a certain type of message is received.

If a receiver is not putting out the correct information, then it will be immediately
identifiable with this window. Also, if a message header is received but the actual
message is corrupted, then the LED next to that message will flash red.
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The Development Data Window

E|Development Data [_ O]

#Time: 00680806023 Int: B828/061/825 ms: B587 = BF BF BF = BF BF =
#Time: B89888824 Int: 8280/861/0825 ms: 8588 = BF BF BF *= BF BF
#Time: 008080025 Int: 82770777025 ms: 68587 = BF BF BF = BF BF
CETD: Hew almanac for S5U 38

#Time: 0080808826 Int: B827/0898/825 ms: 8514 = BF BF BF = BF BF
#Time: 888088827 Int: B827/867/825 ms: 8511 = BF BF BF x BF BF
#Time: 00008828 Int: 827/061/025 ms: 8511 = BF BF BF = BF BF
#Time: 00008829 Int: B828/861/825 mns: @512 = BF BF BF = BF BF

SRAM: Backup PO5:-2483261 -L4L6B6B71 3538367, TOW 162239, WK:99%
#Time: O008088838 Int: 8280/862/0825 ms: B587 = BF BF BF *= BF BF
#Time: 8080808031 Int: 82770847025 ms: 8586 = BF BF BF = BF BF
C5TD: Hew almanac for 5U B

#Time: 808800832 Int: B208/7874/025 nms:
‘#Time: AOOBOA23 Int: B20/866/7025

-650821 = BF BF BF = BF
8511 = BF BF BF = BF BFid

D The Development Data window may be opened by pressing its tool bar
button, or by selecting View >Development Data from the menu bar.

The Sandpiper, Avocet, and Swift receivers can be configured to output regular
development information which contains details about the internal operations of
the GPS unit. This window displays these messages as they are received.

Options for the Development Data window can be found Fart .

by right-clicking on the window and then choosing from the Length...
resulting pop-up menu. The font may be changed to a :

more desired type face. The number of lines that s g el
Conductor keeps in memory is defined by selecting o kel
Length.... The window may also keep lines in a length of Clear

fixed places defined by the user by selecting Fixed
Placement. To keep the window continually viewing the most recent message,
check Hold to Bottom. Select Clear to reset the Development Data display.

To be sure that the receiver outputs Development Data messages, Initialize the

receiver with the Development Data option selected. See Initializing the
Receiver.
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Trickle Power

Some receivers come equipped with a power saving feature called Trickle
Power. When a receiver is placed into Trickle Power mode, it continually shuts
itself off when it is not needing to make GPS measurements. With this mode it is
possible to select the amount of time that a receiver spends in the power off
cycle. The Trickle Power window allows the user to place a receiver into Trickle
Power mode at many different duty cycles.

74 Tickle Power - |O] X |

”E:I-"a' The Trickle Power

Current Duty Cycle IEDX window may be
= opened by selecting
0 N UL Ee— View >Trickle Power from
[~ Push to Fix the menu, or by pressing its
tool bar button.
i Trickle Power Continuous |

A duty cycle may be between 20 and 50 percent. The lower the percentage, the
longer the receiver spends between measurements with the power off. A 20%
duty cycle would set the receiver to take a 200 ms measurement every 1 second.
(Note: Duty cycles above 50 percent automatically put the receiver into
continuous mode.)

By checking the Push to Fix mode, a receiver will sleep in its power saving
mode until the Push-To-Fix (PTF) line is enabled. This is done from pin 20 on the
receiver or with the PTF button on an Evaluation Unit. Once PTF is enabled the
receiver will power on, calculate a navigation fix, output one message set, and
return to the power-saving mode.

Conductor attempts to detect if the GPS receiver is currently in Trickle Power
mode. This is reflected in the ON/OFF indicator. However, this status may not
always be reliable, especially if the antenna signal is very low. Trickle Power also
will not operate properly if there are clock errors due to low signal, or unfinished
acquisition of satellites (for example, right after resetting the unit). If the receiver
is unable to operate in Trickle Power mode, the ON/OFF indicator will turn red.

To reset a receiver back into its normal operating mode (that is, with the power
continually on) press the Continuous button.
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14. Selecting NMEA Message Rates

The Sandpiper, Avocet, and Swift receivers have the ability to customize which
NMEA messages they output, and at what rate. If the message set is in NMEA
mode, then Conductor can set these output rates automatically for you.

NMEA Message Control | | Press the message rates button on the

T navigation display, or click on the
Gea N :1' Messages Received 'window, to display
T the NMEA Message Control window.
[esa 2 = Each of the six possible NMEA messages is
[ Gsv [5 = represented by its three letter identification code.
[eMc i = Shelect which m_essagesdyou wish to output and set
ﬂh—j the output rate in seconds.

Press Set Message Rates and the receiver will
| begin outputting the messages that are selected at
' the indicated rates.

(e Mezzagez

‘ Set Meszage Rates

Mate: This operation iz only walid
with a SiIRF compatible receiver.

Press Query Messages to request that the
selected messages to be sent out only once.

39



Chapter 15 Initializing the Receiver

15. Initializing the Receiver

40

|nitialize

[ Clear Data Flag

[ Clear Memany

[T Raw Track Data
v Development Data

Cancel

|| Hl Selecting Initialize Receiver from the file menu, or

pressing the Initialize button on the tool bar will
display this menu. The options for initializing a
receiver may be selected or deselected.

To perform a Hot start, deselect Clear Ephemeris and
Clear Memory. To perform a Warm Start, select Clear
Ephemeris and deselect Clear Memory. To perform a Cold
Start, select Clear Data Flag, Clear Ephemeris, and Clear
Memory.

The SiRF binary message set has the option of additional messages that contain
more engineering specific data. These messages, The Raw Track Data
message, and the Development Data message may be turned on or off with the
initialization command by selecting or deselecting the respective item on the

menu.
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Chapter 16 The Axiom User1 Message Set

The Axiom User1 Message Set

What is it used for?

Conductor has the ability to use Axiom’s specialized User1 format to

x perform certain functions that aren’t available in standard modes
such as SiRF Binary or NMEA. User1 is used in Axiom’s FMS line of
products that have data logging capabilities.

To switch a data logging receiver between SiRF, NMEA, WARNING

and Axiom User1 modes, use the toolbar buttons that |if your receiver does
represent the message set you would like, or use the |not have data logging
menu items under File ?Message Set. capabilities, or you
are not sure, then do
If your receiver is in Axiom User1 mode, you will notice |not attempt to use
that Conductor does not receive GPS messages on a [Axiom User1 mode.
regular basis. In fact, normal operation in Axiom User1 |You may set your
mode is based on a poll and response system. The trﬁctelver e at m‘.)tdﬁ
receiver will not send any information unless it is ouat O};ou cannot swite
requested. To send commands, use the commands )

window. (see The Commands Window)

The Mobile ID

Another important thing to note about Axiom User1 mode is the use of
identification numbers associated with each unit. For a standard data logging
receiver, this isn’t important, but when you are using hundreds of fleet
management units, it becomes a necessity. Some commands will not be
acknowledged if the receiver sees that the Mobile ID in the command is not the
same as its internal ID. The number internally stored in the unit will be displayed
in the box labeled Mobile ID, as soon as the Conductor receives a message.

The Axiom User1 Status Display

m @ Mohile 1D: -1
'!15- History Complete: 38

i

Downloading a History Log

The primary function of Conductor’'s Axiom User1 mode is to download a history
log that has been stored in the flash memory of the data logging unit. When
Conductor sends a “Hello” message to the unit, it will respond with the number of
records that it has stored in memory. That number will be displayed in the box
underneath the Mobile ID (see above).
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To download a History, simply press the download button that is located on the
right side of the status display (above). The history records will start pouring out
from the receiver to the PC. You will notice that a History Playback window will
appear when Conductor has received any history records. Using the playback
navigation controls, you will be able to step through, or play in sequence all of the
records that came from the unit.

The History Playback Window

Hiztory Plapback

navigate through the history log that
{  has just been downloaded history
_ | log. The log is made up of a series
' | of records that contain the time and
HED':'“:'F of I38 position data that the receiver
logged during its normal operation.

— 5 +—— | The series of buttons across the top
Idl 4 | -1|| F |b-| [ 2 | bll of the window can be used to
| 1 1
. i .

Sawe Hiztory Log az File

The records will be displayed on the
navigation display window, just as the live GPS data was displayed when the
Conductor is using a standard message set. The current record that is being
displayed is shown in the box labeled Record. The total number of records
downloaded is found in the box marked of.

The function of the playback buttons work as follows (left to right): First Record,
Reverse Playback, Previous Record, Pause, Next Record, Forward Playback,
and Last Record. The slider bar underneath the buttons is used to shuttle back
and forth at various speeds through the history log. Pulling the slider to the right
will fast-forward the playback, and pulling it to the left will rewind the playback.
The farther you move the slider, the faster the records change.

Writing a History Log File
If you would like to save the history log to a text file, then press the button

marked Save History Log as File. Conductor will prompt you to enter a file
name that the history log will be saved under.

Special Note:
If you would like to disable or enable the ability to
use Axiom User1 mode with your conductor, then
type the following message while the main display
is the active window:

datalogger
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Glossary

This appendix describes acronyms, abbreviations, and selected terms used in

this document.
2-D
3-D
A/D

Almanac

Altitude

Altitude Hold

Altitude Hold Mode

Baud
Bps
C

C/A Code

Two dimensional.
Three dimensional.
Analog to Digital.

A set of orbital parameters that allows calculation of the
approximate GPS satellite positions and velocities. A GPS
receiver uses the almanac as an aid to determine satellite
visibility during acquisition of GPS satellite signals. The
almanac is a subset of satellite ephemeris data and is
updated weekly by GPS Control.

The distance between the current position and the nearest
point on WGS84 reference ellipsoid. Altitude is usually
expressed in meters and is positive outside the ellipsoid. In
terms of the Sandpiper/Avocet Evaluation Unit, this has no
bearing on the height above mean sea level (which
depends on the time and place, due to gravity of Sun,
Moon, etc.). Determining height with respect to mean sea
level requires making appropriate corrections to the altitude
computed by the Sandpiper/Avocet Evaluation Unit.

A technique that allows navigation using measurements
from three GPS satellites plus an independently obtained
value of altitude.

A Navigation Mode during which a value of altitude is
processed by the Kalman Filter as if it were a range
measurement from a satellite at the Earth’s center (WGS-84
reference ellipsoid center).

See Bps.

Bits per second (also referred to as a baud rate).

Celsius, a unit of temperature.

Coarse/Acquisition Code. A spread spectrum direct
sequence code that is used primarily by commercial GPS

receivers to determine the range to the transmitting GPS
satellite.
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CEP

Clock Error

C/No

Cold Start

Control Segment

dB

dBiC

dBm
dBW
DC

DGPS

Doppler Aiding

DoD

DOP

DSP
DTR

ECEF

Circular Error Probable. The radius of a circle, centered at
the user ’s true location, that contains 50 percent of the
individual position measurement made using a particular
navigation system.

The uncompensated difference between synchronous GPS
system time and time best known within the GPS receiver.

Carrier-to-Noise density ratio.

A condition in which the GPS receiver can arrive at a
navigation solution without initial position, time, current
Ephemeris, and almanac data.

The Master Control Station and the globally dispersed
Monitor Stations used to manage the GPS satellites,
determine their precise orbital parameters, and synchronize
their clocks.

Decibel.

Decibel-Isometric-Circular (measure of power relative to an
isometric antenna with circular polarization).

Decibels per milliwatt.

Decibel-Watt (measure of power relative to one watt).
Direct Current.

Differential GPS. A technique to improve GPS accuracy
that uses pseudorange errors recorded at known locations
to improve the measurements made by other GPS
receivers within the same general geographic area.

A signal processing strategy that uses a measured doppler
shift to help a receiver smoothly track a GPS signal to allow
a more precise velocity and position measurement.

Department of Defense.

Dilution of Precision (see GDOP, HDOP, PDOP, TDOP,
and VDOP).

Digital Signal Processor.
Data Terminal Ready.

Earth-Centered Earth-Fixed. A Cartesian coordinate
system with its origin located at the center of the Earth. The



EEPROM
EHPE
EMC

EMI

Ephemeris

EPROM
EVPE
FP

FRP

GaAs

GDOP

GMT

GPS

Glossary

coordinate system used by GPS to describe 3-D location.
For the WGS-84 reference ellipsoid, ECEF coordinates
have the Z-axis aligned with the Earth’s spin axis, the X-
axis through the intersection of the Prime Meridian and the
Equator and the Y-axis is rotated 90 degrees East of the X-
axis about the Z-axis.

Electrically Erasable Programmable Read Only Memory.
Expected Horizontal Position Error.

Electromagnetic Compatibility.

Electromagnetic Interference.

A set of satellite orbital parameters that is used by a GPS
receiver to calculate precise GPS satellite positions and
velocities. The ephemeris is used to determine the
navigation solution and is updated frequently to maintain
the accuracy of GPS receivers.

Erasable Programmable Read Only Memory.
Expected Vertical Position Error.
Floating-Point mathematics, as opposed to fixed point.

Federal Radionavigation Plan. The U.S. Government
document that contains the official policy on the commercial
use of GPS.

Gallium Arsenide, a semiconductor material.

Geometric Dilution of Precision. A factor used to describe
the effect of the satellite geometry on the position and time
accuracy of the GPS receiver solution. The lower the value
of the GDOP parameter, the less the errors in the position
solution. Related indicators include PDOP, HDOP, TDOP,
and VDOP.

Greenwich Mean Time.

Global Positioning System. A space-based radio
positioning system that provides suitably equipped users
with accurate position, velocity, and time data. GPS
provides this data free of direct user charge worldwide,
continuously, and under all weather conditions. The GPS
constellation consists of 24 orbiting satellites, four equally
spaced around each of six different orbital planes. The
system is developed by the DoD under Air Force
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management, primarily for military purposes, but current
policy calls for civil availability with degradation in system
accuracy to protect U.S. national security interests.

GPS Time The number of seconds since Saturday/Sunday Midnight
UTC, with time zero being this midnight. Used with GPS
Week Number to determine a specific point in GPS time.

HDOP Horizontal Dilution of Precision. A measure of how much
the geometry of the satellites affects the position estimate
(computed form the satellite range measurements) in the
horizontal (East, North) plane.

Held Altitude The altitude value that will be sent to the Kalman filter as a
measurement when in Altitude Hold Mode. It is an Auto
Hold Altitude unless an Amended Altitude is supplied by the
application processor.

Hot Start Start mode of the GPS receiver when current position, clock
offset, approximate GPS time and current ephemeris data
are all available.

Hz Hertz, a unit of frequency.

I/0 Input/ Output.

IF Intermediate Frequency.

IGRF International Geomagnetic Reference Field.

IODE Issue of Data Ephemeris.

JPO Joint Program Office. An office within the U.S. Air Force

Systems Command, Space Systems Division. The JPO is
responsible of managing the development and production
aspect of the GPS system and is staffed by representatives
from each branch of the U.S. military, the U.S. Department
of transportation, Defense Mapping Agency, NATO member
nations, and Australia.

Kalman Filter Sequential estimation filter which combines measurements
of satellite range and range rate to determine the position,
velocity, and time at the GPS receiver antenna.

Km Kilometer, 1000 meters.

L1 Band The 1575.42 MHz GPS carrier frequency which contains

the C/A code, P-code, and navigation messages used by
commercial GPS receivers.
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L2 Band

Latitude

LLA

Longitude

LPTS
LSB

LTP

m/sec
m/sec/sec

m/sec/sec/sec

Glossary

A secondary GPS carrier, containing only P-code, used
primarily to calculate signal delays caused by the
atmosphere. The L2 frequency is 1227.60 MHz.

Halfway between the poles lies the equator. Latitude is the
angular measurement of a place expressed in degrees
north or south of the equator. Latitude runs from 0° at the
equator to 90°N or 90°S at the poles. When not prefixed
with letters N or S, it is assumed positive north of Equator
and negative south of Equator. Lines of latitude run in an
east-west direction. They are called parallels.

Latitude, Longitude, Altitude geographical coordinate
system used for locating places on the surface of the Earth.
Latitude and longitude are angular measurements,
expressed as degrees of a circle measured from the center
of the Earth. The Earth spins on its axis, which intersects
the surface at the north and south poles. The poles are the
natural starting place for the graticule, a spherical grid of
latitude and longitude lines. See also Altitude.

Lines of longitude, called meridians, run in a north-south
direction from pole to pole. Longitude is the angular
measurement of a place east or west of the prime meridian.
This meridian is also known as the Greenwich Meridian,
because it runs through the original site of the Royal
Observatory, which was located at Greenwich, just outside
London, England. Longitude runs from 0° at the prime
meridian to 180° east or west, halfway around the globe.
When not prefixed with letters E or W, it is assumed positive
east of Greenwich and negative west of Greenwich. The
International Date Line follows the 180° meridian, making a
few jogs to avoid cutting through land areas.

Low Power Time Source.

Least Significant Bit of a binary word.

Local Tangent Plane coordinate system. The coordinates
are supplied in a North, East, Down sense. The North will
be in degrees or radians, East in same units and Down will
be height below WGS84 ellipsoid in meters.

Meters per second (unit of velocity).

Meters per second per second (unit of acceleration).

Meters per second per second per second (unit of impulse
or “jerk”).
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Mask Angle

Measurement

MID

MHz
MSB
MSL
MTBF

Multipath Error

mV
mwW
NED
NF

NMEA

NVRAM

Obscuration

OEM

The minimum GPS satellite elevation angle permitted by a
particular GPS receiver design.

The square of the standard deviation of a measurement
quality. The standard deviation Error Variance is
representative of the error typically expected in a measured
value of the quantity.

Message Identifier. In case of SiRF protocol, it is a number
between 1 and 256.

Megahertz, a unit of frequency.

Most Significant Bit within a binary word or a byte.
Mean Sea Level.

Mean Time Between Failure.

GPS positioning errors caused by the interaction of the
GPS satellite signal and its reflections.

Millivolt.

Milliwatt.

North, East, Down coordinate system. See LTP.
Noise Factor.

National Marine Electronic Association. Also commonly
used to refer to Standard For Interfacing Marine Electronic
Devices. Sandpiper and Avocet receivers support Version
2.01 of NMEA 0183 Standard.

Non-volatile RAM, portion of the SRAM that is powered by a
backup battery power supply when prime power is
removed. It is used to preserve important data and allow
faster entry into the Navigation Mode when prime power is
restored. All of the SRAM in the Sandpiper and Avocet
receivers is powered by the backup battery power supply
(sometimes also referred to as “keep-alive” SRAM) when
the main power is turned off.

Term used to describe periods of time when a GPS
receiver’s line-of-sight to GPS satellites is blocked by
natural or man-made objects.

Original Equipment Manufacturer.



Overdetermined

Solution

P-Code

Parallel Receiver

PDOP

Pi

P-P

PPS

PRN

Pseudorange

PVT
RAM

Receiver Channels

RF

Glossary

The solution of a system of equations containing more
equations

than unknowns. The GPS receiver computes, when
possible, an overdetermined solution using the
measurements from five GPS satellites, instead of the four
necessary for a three-dimensional position solution.

Precision Code. A spread spectrum direct sequence code
that is used primarily by military GPS receivers to determine
the range to the transmitting GPS satellite.

A receiver that monitors four or more satellites
simultaneously. The Sandpiper/Avocet Evaluation Unit can
monitor up to 12 satellites simultaneously.

Position Dilution of Precision. A measure of how much the
error in the position estimate produced form satellite range
measurements is amplified by a poor arrangement of the
satellites with respect to the receiver antenna.

The mathematical constant having a value of approximately
3.14159.

Peak to Peak.

Precise Positioning Service. The GPS positioning, velocity,
and time service which will be available on a continuous,
worldwide basis to users authorized by the DoD.

Pseudorandom Noise Number. The identity of the GPS
satellites as determined by a GPS receiver. Since all GPS
satellites must transmit on the same frequency, they are
distinguished by their pseudorandom noise codes.

The calculated range form the GPS receiver to the satellite
determined by measuring the phrase shift of the PRN code
received from the satellite with the internally generated PRN
code from the receiver. Because of atmospheric and timing
effects, this time is not exact. Therefore, it is called a
pseudorange instead of a true range.

Position, Velocity, and Time.

Random Access Memory.

A GPS receiver specification which indicates the number of
independent hardware signal processing channels included

in the receiver design.

Radio Frequency.
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RFI Radio Frequency Interference.

ROM Read Only Memory.

RTCA Radio Technical Commission of Aeronautics.

RTCM Radio Technical Commission of Maritime Services. Also

commonly used as a reference to the standard format that
DGPS corrections data is distributed in (“RTCM
Recommended Standard for Differential Navstar GPS
Service”). Sandpiper and Avocet receivers support the
latest Version 2.1 of this standard.

SA Selective Availability. The method used by the DoD to
control access to the full accuracy achievable with the C/A
code.

Satellite Elevation  The angle of the satellite above the horizon.

SEP Spherical Error Probable. The radius of a sphere, centered
at the user ’s true location, that contain 50 percent of the
individual 3-D position measurements made using a
particular navigation system.

Sequential Receiver A GPS receiver in which the number of satellite signals to
be tracked exceeds the number of available hardware
channels. Sequential receivers periodically reassign
hardware channels to particular satellite signals in a
predetermined sequence.

SNR Signal-to-Noise Ratio, often expressed in decibels.

SPS Standard Positioning Service. A position service available
to all GPS users on a continuous, worldwide basis with no
direct charge. SPS uses the C/A code to provide a
minimum dynamic and static positioning capability.

SRAM Static Random Access Memory. In context of this
document, see also NVRAM.

SV Satellite Vehicle.

TDOP Time Dilution of Precision. A measure of how much the
geometry of the satellites affects the time estimate
computed from the satellite range measurements.

3-D Coverage The number of hours-per-day with four or more satellites

visible. Four visible satellites are required to determine
location and altitude.
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3-D Navigation

TTFF

2-D Coverage

2-D Navigation

UART

UDRE

UERE

Update Rate

uTcC

VCO

VDOP

VSWR

Glossary

Navigation Mode in which altitude and horizontal position
are determined from satellite range measurements.

Time-To-First-Fix. The actual time required by a GPS
receiver to achieve a position solution. This specification
will vary with the operating state of the receiver, the length
of time since the last position fix, the location of the last fix,
and the specific receiver design. See also Hot Start, Warm
Start and Cold Start mode descriptions.

The number of hours-per-day with three or more satellites
visible. Three visible (hours) satellites can be used to
determine location if the GPS receiver is designed to accept
an external altitude input (Altitude Hold).

Navigation Mode in which a fixed value of altitude is used
for one or more position calculations while horizontal (2-D)
position can vary freely based on satellite range
measurements.

Universal Asynchronous Receiver/Transmitter that
produces an electrical signal and timing for transmission of
data over a communications path, and circuitry for detection
and capture of such data transmitted from another UART.

User Differential Range Error. A measure of error in range
measurement to each satellite as seen by the receiver.

User Equivalent Range Error.

The GPS receiver specification which indicates the solution
rate provided by the receiver when operating normally. It is
typically once per second.

Universal Time Coordinated. This time system uses the
second defined true angular rotation of the Earth measured
as if the Earth rotated about its Conventional Terrestrial
Pole. However, UTC is adjusted only in increments of one
second. The time zone of UTC is that of Greenwich Mean
Time (GMT).

Voltage Controlled Oscillator.

Vertical Dilution of Precision. A measure of how much the
geometry of the satellites affects the position estimate
(computed from the satellite range measurements) in the
vertical (perpendicular to the plane of the user) direction.

Voltage Standing Wave Ratio.
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WAAS

Warm Start

WGS-84

Wide Area Augmentation System. A system that augments
GPS by using geostationary satellites to broadcast
differential GPS corrections on the same frequency as the
GPS signals.

Start mode of the GPS receiver when current position, clock
offset and approximate GPS time are input by the user.
Almanac is retained, but ephemeris data is cleared.

World Geodetic System (1984). A mathematical ellipsoid
designed to fit the shape of the entire Earth. It is often used
as a reference on a worldwide basis, while other ellipsoids
are used locally to provide a better fit to Earth in a local
region. GPS uses the center of the WGS-84 ellipsoid as
the center of the GPS ECEF reference frame.
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